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HI RITE is a word-processing software tool. You can write without
a pen, erase without an eraser, and move sentences without
cutting and pasting or rewriting. It is a quick and efficient way to
write and edit text, whether the document is a letter to a friend or a
research report.

TRACK is an electronic worksheet that stores numerical informa
tion, such as batting averages or financial information. Titles,
numbers, and formulas are entered in a spreadsheet. TA ACK per
forms calculations and, most importantly, recalculates when you
insert or change numbers and formulas. Finished spreadsheets
can display budgets, cost comparisons, and projections neatly and
efficiently.

MANAGE is a database management software tool, an electronic
filing system. It stores information quickly, and sorts or finds
stored information. MANAGE reviews the information in a file and
then locates the requested data. It extracts the information and
organizes it into a useful form.

Work can be saved on a data disk and used again later.

The three tools in first hand work together. MANAGE and
TAACK files can be merged into UIAITE files, producing one docu
ment with several types of data.

User Tips

O User tips (marked with the lightbulb symbol) give extra in-
formation about certain operations.

GETTING STARTED

Necessary Hardware
FIRST HAND runs on the IBM PC, XT or AT, and many IBM-compatibles with at
least one disk drive and a minimum of 256K of RAM. The program also runs on
an Apple ll/e, ll/c, and ll/gs with at least one disk drive and a minimum of 128K of
RAM. A printer is optional.



Installing DOS
FIRST HAND runs under DOS version 2.0 or later. (If your machine is already
running under DOS, and the A> prompt is on the screen, skip this step.)

1. Open the disk drive door.
2. Insert DOS (version 2.0 or later) in drive A.
3. Close the disk drive door.
4. Turn on the monitor and computer. The red light on the disk drive goes on.

A> appears on the screen. (See below, How to Begin.)

Floppy Disks
Work files are stored on a separate data disk, formatted with DOS. Use a format
ted disk with other files on it, or format a new or old disk, following instructions in
your DOS manual. (Caution! before formatting an old disk, be sure no one needs
the old files.) Remember, if your machine has two drives, use Drive 1 for the
tool program disk, and Drive 2 for your data disk.

How to Begin
When the A> prompt appears, remove the DOS disk, insert the appropriate tool
disk and type FIRST. If you have only one disk drive, press <ESC> when you
are prompted to put your data disk on drive 2. Then use <F1> to pull down the
File Menu. Move the highlight to Data drive and press <ENTER/RETURN>.
Change the drive from 2 to 1. When prompted, insert your data disk into drive 1.
tf «tYou can boot directly from the program disk. On the Apple use Data drive A
for Data drive 1 and Data drive B for Data drive 2.41

Screen Design
The main screen areas are illustrated in the diagram on the following page. As
you work, you learn where to look for information. When a menu is displayed, it
is "pulled down" over the workspace area.
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USER
WORKSPACE

displays the portion of the document,
file, or spreadsheet you are working on

Appropriate messages and warnings
appear in a bott in this area

Prompts and other information about the current operation

k S t a t u s i n f o r m a t i o n J

Once an option is selected, the pull-down menu is cleared from the workspace. You
can also clear the workspace by pressing <F2> 44 <OPEN APPLE>## or <ESC>.



KEYS
Listed below are some of the most frequently used keys:

IBM: Apple:
<F1> <CLOSED APPLE> Help
<F2> <OPEN APPLE> Menu
<F3> <CTRL-S> Save
<F4> Open
<F5> <CTRL-P> Print
<ESC> <ESC> cancel a command, back out of a

screen
<ARROWS> <ARROWS> move the cursor
<BACKSPACE> <DELETE> erase "backward" (to the left of the cur

sor)
<DEL> <CTRL-D> erase "forward" (erase the cursor char

acter or space)
<INS> <CTRL-0> change between INSERT and OVER-

STRIKE
Command keys
When you see CTRL- (orA ) followed by a letter, hold down the Control key
while you press the letter key.

Screen Colors
With the IBM version, if you have a color monitor, you can select screen colors
for each tool. Press CTRL-Z (when no menu is pulled down) to display the color
selection screen. Follow the prompts to make changes in foreground and back
ground colors. When you are satisfied, press CTRL-X to save your choices and
return to the workspace.
(If some screen areas are difficult to read, and you are using a color card and a
monochrome monitor, try different color settings to see if it helps.)

Highlighting
Highlighting displays characters or screen areas on a color or white background.
It is used to emphasize or mark something. Use arrow keys to highlight words,
sentences, lines, and paragraphs.

Choosing Menu Options
When you begin, the File menu is pulled down, with the "New..." option highlighted.
Use right or left arrows to display a different menu. Use up or down arrows to high
light a menu option, and press <ENTER/RETURN> to select it. (If an option is not
active, it is marked with a bar to the left of the option and you cannot select it.)
Shortcut keys are listed next to some menu options. If you know which key to
press, you can type in the appropriate keys without pulling down a menu and select
ing. Some commands have sub-options. Sub-option choices appear in the prompt
area at the bottom of the screen.



MAV MENU OPTIONS
MRU File Edit Find Display
About WRITE ...
Help

Date driue...

About... displays name of the developer and the publisher of this software.

Help (<F1> or 44 <CLOSED APPLE>) is available from any part of the pro
gram. Some pages in the HELP BOOK give general information; others tell
about the operation that is presently active. Most of the information in this guide
is included in the HELP BOOK.

Use the HELP BOOK
• for information about a specific operation.
• for an introduction to the tool. (Scroll through the first few HELP pages.)
• as a tutorial. (Start at page 1 and read the HELP BOOK.)
• to see command and shortcut keys, on the last two pages.

Help commands

IBM: Apple:
<F1> <CLOSED APPLE> display HELP for the current
(or Help from menu]I operation.
<ESC> <ESC> exit the HELP BOOK (and return to

your place in the program).
<ARROWS> <ARROWS> move forward or backward through

the HELP BOOK.
<PgUp/PgDn>
<HOME> <CTRL-B> go to Page 1
<END> <CTRL-E> go to the last page

Data Drive looks for the data disk and displays the directory of files made with
the tool.

Ill RITE files have the extension .WRI
TRACK files have the extension .SPR
MANAGE files have the extension .DAT

If the wrong drive is selected, use the Data Drive command to enter the correct
drive letter. For single-drive systems, the program prompts you to switch be
tween the program disk and the data disk.



FILE MENU OPTIONS

New begins a new file. Enter a filename (up to 8 characters). Then begin work.

Open (<F4>) loads any file saved on your data disk that was saved with one of
the three tools. Select Open (when no file is open), highlight a filename, and
press <ENTER/RETURN>.

Close closes a file. A prompt will ask you if you want to save your work before
you close the file. If you say N for no, you close your file without saving it.

Insert File merges files. Locate the cursor where the file is to be inserted, se
lect Insert File, type the name of the file to insert, and press <ENTER/RETURN>.
Any file made with this program may be inserted into any file on which you are
currently working. UPRiTE files may be created with MANAGE or TAACK.

Save (<F3> or ## <CTRL-S> ##) saves the open file in its present ver
sion, and allows you to continue working on it. (To stop working, use Close.) A
warning message appears when there is not enough room on your data disk to
save the file. If this happens, remove the full data disk that is in the drive and in
sert another disk.

9 Save the present version of a file before trying changes that mightnot work. If you don't like the new version, Close the file without
saving.

MANAGE saves in a different way from UIAITE and TRACK. (See Save
Record in the MANAGE section of this guide.)

Copy File duplicates files made with the current tool. To copy a file onto the
same disk, select the filename and enter a new filename. To copy a file to a dif
ferent drive, enter:

drive letter, colon, file name

When copying to a different drive, use the same filename or a new one.

Rename gives a new name to any file on your data disk.

Erase deletes files made with FIAST HAND. Use Erase to get rid of old files,
and to free up space on your data disk.

Quit exits the program.



WUOT!
HI AITE is a word processing tool. Use it to type, as on a typewriter. Unlike a
typewriter, you can make changes and corrections before you put anything on
paper. Work is saved on disk, so it can be edited at a later time. You can easily
combine several WRITE files, or combine files made with WRITE, MANAGE, and
TAACK.

The editing functions of 111 A ITE include inserting, deleting, moving, copying, find
ing, and replacing text, and specifying margins, line spacing and page breaks.
Printed text can be centered, underlined, or boldfaced. Because revising is so
easy, 111 A ITE is useful for creative writing or reports. It is also handy for creating
documents that you will use more than once. For example, to write to several
computer stores, you save your first letter and copy it; then you change the name
and address to make other letters.

GLOSSARY OF WRITER TERMS
<ARROWS> move the cursor around the workspace. Right and left arrow
keys move the cursor one space at a time. Down and up arrows move the cur
sor one line at a time, to the equivalent place on the next line. Scroll by pressing
the down arrow at the bottom edge of the work space (or the up arrow at the top
edge). This scrolls the contents of the window so a new part is visible.

<SHIFT> for capital letters and symbols that are shown on the top half of keys.

<BACKSPACE> or 44 <DELETE> ** erases "backward" (left of the cursor).

<DEL> or *tf <CTRL-D> ##erases "forward" (cursor character or space). To
erase more than a few characters, use Delete from the menu. (See Delete, be
low.)

Word wrap moves text to a new line if a word doesn't fit on the line. Don't
press <ENTER/RETURN> at the end of each line.

<ENTER/RETURN> begins a new line. Press <ENTER/RETURN> twice to
put an extra blank line between paragraphs.

<TAB> indents five spaces.
Indent a block of text by using <CTRL-L>. (See Left Margin, Right Margin, be
low.)

<INSERT> or *rt <CTRL-0> tf tf enters characters at the cursor. Use
<ARROWS> to locate the cursor; then type to enter text to the left of the cursor.

Overstrike enters characters, writing over existing characters.



TO BEGIN A NEW FILE
1. Choose New from the File Menu.

(Be sure you have a formatted data disk in the selected Data Drive.)
2. Name the file.
3. Begin typing text. Type in words, numbers, and spaces.

FILE MENU OPTIONS
Imru File Edit Find Displaq

New...
Open...
Close
Insert File...

Saue...
Print...

Copy File...
Rename...
Erase...

Quit

New [See Introduction]
Open [See Introduction]
Close [See Introduction]
Insert File [See Introduction]
Save [See Introduction]
Copy File [See Introduction]
Rename [See Introduction]
Erase [See Introduction]
Quit [See Introduction]

Print (<F5> or «# <CTRL-P> ««) prints the file you are working on. Print
values are pre-set as shown in the right-hand column below. They may be
changed, within the limits in parentheses. The program does not allow you to
use numbers beyond those limits. Values remain as set until changed again, or
until you reload the tool. (Then they revert to the default values.)

Left Margin (1 - 65)
Right Margin (10-122)
Line Spacing (1 - 3)
Top Line (1 - 60)
Bottom Line (7 - 90)
Paper Length (6 - 90)
Stop between Pages (Y or N)
Page Numbering (Y or N)
Start at Page
Stop after Page

10
75

1
7

60
66
N
Y
1

99



Change "Stop between Pages" to Y for yes if you intend to feed sheets of paper
by hand. If the Line Spacing does not come out as you expected, check your
printer manual for setup routines.

9 Use Preview Print before printing, to see the effects of control com
mands and print menu commands. (See below, Preview Print)

EDIT MENU OPTIONS
| M R U F i l e E d i t F i n d D i s p l a y

Undo
Copy...
Moue...
Delete...

Ouerstrike

Undo (<F9> or «« <CTRL-Z *«) cancels the last Move, Copy or Delete
command. (You cannot undo other commands.) You can only use the Undo func
tion immediately after you've moved, copied, or deleted text and before pressing
any other keys.

9 Before trying something fancy, save your file. If you don't like the re
sults, close the file without saving the new version.

Copy (<F7>) duplicates a part of your document. Highlight the text to copy,
move the cursor to the place for the copy and press <ENTER/RETURN>. The
text will appear in both places. If your file is very large, you may need to divide it
before you can copy text (See Copy File, above). Follow these directions to di
vide one file into two parts:

1. Save the file and copy it; name the copy "PART2" for example.
2. Load the original, and delete the last half; then save it.
3. Load "PART2," and delete the first half.

Move (<F8>) allows you to mark a part of your document and move it to anoth
er place in your document. Highlight the text to move, move the cursor to the new
location and press <ENTER/RETURN>.

Delete allows you to mark a part of your document and erases it. Highlight the
text to delete and press <ENTER/RETURN>.

Insert (INS or #« <CTRL-0> ##) allows you to switch between Insert and
Overstrike text entry mode. INS appears in the bottom right corner of the screen
when "Insert" is selected.

8



FIND MENU OPTIONS
iMRLI File Edit Find Display

Find...
Replace.

Find locates every occurrence of a "string" of characters. (A "string" is any
combination of letters, numbers, symbols, and spaces that you enter. It can be
one letter, part of a word, or several words, up to the limit of 25 characters.) En
ter upper and lower case characters and spaces, exactly the way you want them
found. Find starts at the cursor, loops through the end of the file and back to the
cursor position until every instance of the string is found. Press <ESC> to cancel
Find.

9 To find a word whether or not it's capitalized, omit the first letter.
(Type "ome" to find "Home" as well as "home.")

Replace replaces strings of characters. For example, if you had typed "Jon-
son" instead of "Johnson," you could easily correct it everywhere it occurs. Type
upper and lower case characters and spaces, exactly the way you want them
found, and type exactly what you want used instead. Each time the string is
found, the program asks if you want to replace it. Replace strings may be up to
25 characters. <ESC> stops the Replace command, but leaves all the changes
already made.

MENU OPTIONS
Imru File Edit Find Display

Dold
Underline

Center
Left Maryin
Right Margin
New Page
Line Spacing

Page & Line Count
Pre mew Print

These commands change the way your document will look. When you use them,
a highlighted symbol appears on the screen. (For example, C> marks the loca
tion of a centering command.) Erase unwanted symbols just as you erase text.
(Symbols don't appear in print, but tell the printer what to do.)



Bold (AB) Select this command right before and after the characters you want
to boldface. On screen, B> marks the beginning of boldface and <B the end.

Underline (AU or «# <CTRL-Y> ##) Select this command right before
and right after characters you want underlined. On the screen, U> marks the be
ginning of underlining and <U marks the end.

Center (AC) Select the center command to mark the beginning of the text you
want centered. C> marks the beginning of centering. Everything will be centered
until the next carriage return. (If text to center is longer than one line, both lines
will be centered.)

Left Margin (AL) Each time you give this command, the left margin is indent
ed 5 spaces. (Select this command twice for 10 spaces, etc.) The indentation re
mains in effect until the program encounters a carriage return in your text.

9 To indent the first line of a paragraph five spaces, use TAB instead.
If you use AL the whole paragraph will be indented. To change the
margins for an entire document, set the margins from the Print op
tions menu. (See Print above.)

Right Margin (AR) indents the right margin 5 spaces each time you press it.
(Select this command twice for 10 spaces, etc.) The change is in effect until the
program encounters a carriage return. To set off a long quotation in a research
paper, change both the left and right margins.

New Page (AN) starts a new page. The symbol N> is displayed, and the cur
sor moves to the next line.

Line Spacing (AS or «* <CTRL-W> ##) sets spacing at single, double,
or triple (1> 2> or 3>). The spacing remains as set, until you change it. This
command is useful when you want to change line spacing for part of a document.

Page & Line Count shows you the page and line for the current cursor position.

Preview Print displays a facsimile of a printed page on the left- hand side of
the screen, and the text on the right. It shows the effects of formatting com
mands on your document-centering, spacing, etc. <ARROWS> move the cur
sors. Cancel Preview Print to resume editing the file, with the cursor at that loca
tion. Preview Print does not display on a computer without a graphics card.

WRITE CAPACITY
File depending on the margins used, about 20 to 22 pag

es, double-spaced (less if single-spaced, more if
triple-spaced), tfft 14-16 double spaced pages **

String for Find up to 25 characters, including spaces.
or Replace

10



TAACK is an electronic "spreadsheet." On paper spreadsheets, printed lines
mark off rectangles. You write words and numbers in the rectangles, and use
your calculator or your math skills to add, subtract, multiply, and divide. Changes
require an eraser; you start all over if there are too many changes.

With TAACK you type in words, numbers, and formulas in rectangles, called
"cells," and then perform different operations and make changes in your work.

^ ^ ■ s ^ ^ ^ ^ sWSSM^ ^ ^ ^ ^ M^ ® \

JULY AUGUST

EARNINGS 80.00 80.00
BONUSES 40.00
TOTAL INCOME 120.00 80.00
EXPENSES 30.00 20.50
SAVED THIS MONTH 50.00 99.50
TOTAL SAVINGS 100.00 199.50

Prompts and other information about the current operation
L Status information J

Entered in this spreadsheet are:

columns JULY and AUGUST
rows EARNINGS, BONUSES, TOTAL INCOME, EXPENSES, SAVED

THIS MONTH, and TOTAL SAVINGS
cell data the value for AUGUST, EARNINGS is 80.00
formulas TOTAL INCOME adds EARNINGS and BONUSES

Values and formulas can be changed to see how change affects the results, and
then changed back if desired. Data can be displayed in different ways. (In the
sample, the left-hand title column was made wider, to display longer titles.) Col
umns and rows can be deleted, inserted, or moved to new places on the spread
sheet. (In the sample, a row was inserted to separate the titles from the data.)
One or several versions of the spreadsheet can be saved to use again, or printed.

GLOSSARY OF SPREADSHEET TERMS
Row the cells in one horizontal line (including title cells and empty cells). The
maximum is 250 rows (counting the title row).

11



Column the cells in one vertical line (including title cells and empty cells). The
maximum is 27 columns (counting the title column).

Title the name of a row or column. When you begin, rows have 1 - 249 for titles;
columns have A-Z. When you enter a title, it replaces the number or letter.

Cell the intersection of a row and a column. The cell in which you are presently
working is highlighted.

Cell Address the location of a cell. It is given as column, comma, row. In the
sample, 20.50 is in cell B,5. If you give its address in titles, it's AU-
GUST.EXPENSES.

Expanded Formula a formula expressed using titles. The Expanded Formula
command changes the way cell addresses are expressed: B,2+B,3 becomes AU-
GUST,EARNINGS+AUGUST,BONUSES.

Range a rectangle of cells. A range can be part or all of a row or column, or a block
of cells somewhere in the middle of the spreadsheet. To specify a range, enter a co
lon between two cell addresses: AUGUST,EARNINGS:AUGUST,BONUSES or
B,2:B,3.

Operation the arithmetic function used in a formula. (See Formulas,; below for
the symbols to use.)

Text anything (letters, numbers, symbols) that you enter when the prompt reads
TEXT instead of NUMBER.

Cell Contents the words, numbers, or formulas in a cell. A cell displays as
many characters as will fit. When a cell is highlighted, the full text, number, or
formula is displayed in the Status Area. A cell displays the result of a formula.
Highlight a cell to display its formula in the Status Area (see Width, below, for
widening cells).

Best fit numbers displayed in the form that fits the column width best.

Integer numbers displayed as whole numbers.

Dollar numbers displayed with two decimal places.

Decimal numbers displayed with five decimal places.

TO BEGIN A NEW FILE:
1. Choose New from the File Menu.

(Be sure you have a formatted data disk in the selected Drive.)
2. Name the file.

12



3. You will see a "window," a portion of the entire spreadsheet. The highlight
is in cell A,1.

4. To move around the spreadsheet, use:
<ARROWS> to move up, down, left, or right
Goto or <TAB> then enter a cell address to go to a certain cell.
<HOME>togotocellA,1.
<END> to go to the end of your work.

5. To Enter titles, highlight a cell, press <SPACE>, and type.
Titles entered in the title cells (the top row and left-hand column) remain on
the screen, even when you "scroll" to another part of the spreadsheet.
Numbers entered in title cells do not calculate.

6. To enter text in the body of the spreadsheet, the status must be set at
TEXT. To "toggle" from NUMBER to TEXT, press CTRL-T (or select Num
ber from the Edit menu). Numbers entered as text do not calculate. (The
program ignores them.)

7. To enter a number or formula, highlight a cell and type. Be sure the status
is set to NUMBER. (See Formulas below.)

8. To correct data, highlight a cell, press <SPACE>, and change the contents.
(To erase everything in a cell, use Blank. See below.)

9. To recalculate after entering numbers or formulas, select Calculate (or
press <=>).

FORMULAS
Formulas can be simple (with just one arithmetic operation) or complex (with sev
eral). When you enter a formula, it appears in the Status Area. Its calculated
value is displayed in the cell. Enter formulas with or without spaces, using capital
or lower case letters.

The formula symbols are:

+ a d d i t i o n
subtraction

* m u l t i p l i c a t i o n

/ d i v i s i o n
S U M a d d a r a n g e o f c e l l s
AV E a v e r a g e a r a n g e o f c e l l s
SIN ca lcu la te the s ine o f an ang le
COS calculate the cosine of an angle
TAN calculate the tangent of an angle
SORT calculate the square root of a number

Formulas are read from left to right and calculated in normal mathematical order:

1. SUM, AVE, SIN, COS, TAN, SORT
2. Operations inside of parentheses
3. Multiplication and division
4. Addition and subtraction

13



Symbols for entering formulas:

Parentheses ()
to enclose cells included in the range for a SUM or AVE formula.
Example: AVE(B,3:B,7) adds cells B,3 through B,7 and divides by the number of
cells that are not empty.

to enclose a number or a cell address used for a SIN, COS, TAN, or SORT cal
culation.
Example: SQRT(64)

to mark an operation to be performed first.
Example 22+(3*28/7)

Colon :
to separate the first and last cell in a range.
Example: B.1:B.1Q

Comma , (may be entered if you wish)
to separate the column and row in a cell address. Type the column first, then the
row. (If you choose not to enter commas, the program will do it for you).
Example: AUGUST, EXPENSES or B,7

SUM
to add the cells in the range that follows.
Example: SUM(A,1 :A,10) adds the ten cells from A,1 through A,10.

AVE
to average the cells in the range that follows.
Example: AVE(B,5:B,10) adds the values of the 6 cells in the range, then divides
the total by the number of cells that have data in them.

SIN, COS, TAN (IBM version only)
to calculate the sine, cosine or tangent of an angle.
Examples: SIN(90) calculates the sine of a right angle. TAN(C,6) calculates the
tangent of the angle in cell C,6.

SORT (IBM version only)
to calculate the square root of a value.
Example: SQRT(25) calculates the square root of 25.

9 Use the cell pointer command <F10> to enter the value of a cell into
a formula. Locate the cursor in the cell to contain the formula and
press <F10>. Then move the cursor to the cell that contains the de
sired value and press <ENTER/RETURN>. The address of the cell
will be entered into your formula. This is an IBM only function.

14



WARNINGS AND ERROR MESSAGES
??? Your formula cell refers to itself and it cannot be calculated.

>» The calculated value is too large or too small (too close to zero) for the
computer to calculate.

XXX The cell isn't wide enough to display its value without leaving out a signifi
cant part.

Error in formula Your formula is not valid. The program locates the cursor
close to the place where the error occurs. This error message may also indicate
that you have used <Backspace> or <DEL> to erase a cell, instead of Blank.

Data in last column/row. Destroy? Y or N Your copy or insert command
will destroy data and, if you type Y the Undo command cannot cancel the com
mand, nor can you escape.

No more memory left When this message appears, save your file right away.
If you try to enter data, the results are unpredictable.

FILE MENU OPTIONS

IMRU File Edit Find Display
New...
Open..
Close

Saue...
P r i n t -
Copy for Writer..

Copy File...
Rename...
Erase...

Quit

New [See Introduction]
Open [See Introduction]
Close [See Introduction]
Save [See Introduction]
Copy File [See Introduction]
Rename [See Introduction]
Erase [See Introduction]
Quit [See Introduction]

Print (<F5> or «« <CTRL-P> 44) prints the file you are working on.
When you load TAACK, print values are set as in the right-hand column. They
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may be changed, within the limits in parentheses. The program does not allow
you to use numbers beyond those limits. Values remain as set until changed
again, or until you reload TAACK. (Then they revert to the default values.)

Left Margin (1 - 65)
Right Margin (10-122)
Line Spacing (1-3)
Top Line (1 - 60)
Bottom Line (7 - 66)
Paper Length (6 - 90)
Stop between Pages (Y or N)
Page Numbers (Y or N)

10
75
1
7

60
66
N
Y

Some spreadsheets (such as those with many columns, or those with wide mar
gins) print on several pages, which you can tape together. Column titles print
once for every two pages. (To print them on every page, choose Y for Stop be
tween Pages.) Choose "Stop between Pages" to feed sheets of paper by hand.
If the Line Spacing is not what you expected, check the printer manual for setup
routines.

Copy for Writer saves the current TAACK file as a HI A ITE file. In WRITE you
can Open the file or insert it into another HI RITE file. Print menu selections
made in TAACK will affect the appearance of the IDA ITE file.

EDIT MENU OPTIONS
IMRU File Edit Find

Number

Dndo
Insert...
Delete...
Blank...
Copy...
Moue...

Ouerstrike

Display 1

DISPLAY

Number (AT) switches between NUMBER and TEXT.

Undo (F9 or ## <CTRL-Z> **) cancels a command of Insert, Delete,
Blank, Copy, Move, Width, Best Fit, Dollar, Integer, or Decimal. You can only
use the Undo command immediately after you've moved, copied, or deleted text
and before pressing any other keys.

Q Undo won't work after you recalculate. Before trying something fan-* cy, save your file. If you don't like the results, close the file without
saving the new version.
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Insert inserts blank rows or columns. Highlight the row below the new row's lo
cation, or the column to the right of the new column. Press <ENTER/RETURN>,
then press < = > to recalculate. A warning appears if your insert command will
destroy data in the last row or column.

Delete (<F6>) removes rows or columns (and the data they contain). High
light the rows or columns to remove, and press <ENTER/RETURN>. After De
lete, the spreadsheet closes up-no blank space is left.

9 To get rid of a column or row and its contents, use Delete.
To remove only the contents of cells, use Blank.

Blank erases the contents of a cell, row, or column. Highlight the cell, column,
or row to blank, and press< ENTER/RETURN>. The empty cell, column, or row
remain. Use Blank (instead of the Delete key or <BACKSPACE>) to remove
everything in a cell. (Otherwise, a formula error message appears.)

Copy (<F7>) copies the contents of a cell, one or more rows or columns, or a
range of cells. Highlight the cells to copy and press <ENTER/RETURN>. Then
highlight the location for the copy, press <ENTER/RETURN> again, and press
< = > to recalculate. A warning appears if your copy command will destroy data.

Move (<F8>) relocates the contents of a cell, one or more rows or columns, or
a range of cells. Highlight the part to move, and press <ENTER/RETURN>.
Then highlight the new location, press <ENTER/RETURN> again, and press < =
> to recalculate. A warning appears if your move command will destroy data.

9 You can mark any rectangular block on the spreadsheet for purpos
es of Blank, Copy, or Move. Locate the cursor at one corner of the
block to mark before you select the command. Give the chosen
command (or select it from the menu), move the cursor to the oppo
site corner of the block, and press <ENTER/RETURN> to complete
blocking the rectangle.

Insert (INS or tf # <CTRL-0> ##) switches between Insert and Overstrike
text entry mode.

FIND MENU OPTIONS
| m r » F i l e E d i t F i n d D i s p l a y I

Calculate
G o t o T R B

Calculate (< = >) recalculates spreadsheet values after changes.

Goto (<TAB>) This command, followed by a cell address, moves the highlight
to that cell.
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' MENU OPTIONS

|mru File Edit Find Display
Width

Best fit
Integer
Dollar
Decimal

EHpanded

If you format the entire spreadsheet before you enter data, everything you enter
appears in that format.

Width widens or narrows either columns or the whole spreadsheet. When you
begin, width is set at 9 (8 characters and a space). Columns width can be as
narrow as 2 (1 character plus a space), as wide as 19 (18 characters plus a
space).

Best Fit displays data the best way possible, within the present cell width.
(Numbers are rounded, text cells show as many characters as fit.) Best fit is the
default setting when you begin a new file.

Integer displays values as whole numbers; 294.4 is displayed as 294.

Dollar displays values with two decimal places; 25 is displayed as 25.00.

Q To display a dollar sign, set aside a narrow column, and enter the $9 symbol as text where you want it.

Decimal displays values with five decimal places; 25 is displayed as 25.00000.

Expanded Formula (AX) displays formulas using cell titles (See Glossary,
above.)

TRACK CAPACTITY
# of Columns 27 including title column
# Of ROWS 250 including title row
Ti t l es up t o 19 cha rac te r s
Text display as many characters as fit in current column width
Numbers up to 9 digits
Decimals up to 5 decimal places
Formulas up to 100 characters
Column display up to 19 characters

18



MANAGE is a "database manager," a tool used to store, organize and retrieve in
formation. Information is entered; then the program puts it in order ("Sorts"), or
selects specified parts ("Finds").

Suppose you wanted to put information from your address book into the comput
er. Two entries in your address book might look like this:

Sue Glenn
47 Lakewood
Greenwood, TX 70235
(814)555-4567

James Rodriguez
22 Chester
Sun Prairie, TX 70256
(814)555-6543

The same information looks like this on the MANAGE screen:

r
H f W fi l e t m n * w t : : : : v : v x ^ ^

Name
Street

Glenn, Sue
47 Lakewood

Town Greenwood
State TX
Zipcode
Phone number

70235
814-555-4567

Name
Street

Rodriguez, James
22 Chester

Town Sun Prairie
State
Zipcode
Phone number

TX
70256
814-555-6543

Prompts and other information about the current operation
l Status information i i 1

After all the data is entered, MANAGE could do things like:

Find everyone who lives in Texas.
Find the people who live in Sun Prairie.
Find the people who dont live in Sun Prairie.
Put the file in alphabetical order by last names.
Put the file in alphabetical order by town.
Add new fields, for instance "Birthdate" or "Age."
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Some uses for MANAGE include: mailing lists, an inventory of valuables, club or
organization information, recipes, personal hobbies or collections. MANAGE is
also useful for creating files for research reports.

GLOSSARY OF SPREADSHEET TERMS
File or Database A collection of information about a subject.
(The ADDRESS file holds records for a number of friends.)

Fields The categories of information about the subject.
(Street is the second field in the ADDRESS file.)

Field Name The names or words used to describe each field.
(The fields in the ADDRESS file are Name, Street, Town, State, Zipcode, and
Phone number.)

Value The specific information (or "data") in a field.
(The field value for Town in the record about Sue Glenn is Greenwood.)

Record All the data about one person or thing in a file.
(Record #1 contains all the information about Sue Glenn.)

Find To select all the records with a certain field value.
(Find records for friends who live in TX.)

Sort To arrange records in a chosen order.
(Sort by Name, to alphabetize the file.)

TO BEGIN A NEW FILE
1. Choose New from the File Menu.

(You must have a formatted data disk in the selected Data Drive.)
2. Name the file.
3. Name the first field and specify its maximum length. Then press <CTRL-

A> or <PgDn> to name the next field.
4. When all the fields are named, press <CTRL-X> or <F10> to save the file

structure.

Add a few records, and try using SORT and FIND to see if the file design works.
If not, change the file structure, or erase the file and start again. It's easier to
scrap a small test file than edit a lot of data. (See Add Record, Find, Sort Up or
Sort Down below.)

FILE MENU OPTIONS
New [See Introduction]
Open [See Introduction]
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■ MRU File Edit Find Displaq
New...
Open...
Close

Saue Record
Sane Subset...
P r i n t -
Print Labels...
Copy for Writer..

Copy File...
Rename...
Erase...

Quit

Close [See Introduction]
Copy File [See Introduction]
Rename [See Introduction]
Erase [See Introduction]
Quit [See Introduction]

Save Record (<F3> or «« <CTRL-S> ##) saves the record you have
just entered or edited. The record remains on the screen. There is no Save
command for MANAGE. When a file is created, its filename and structure are
saved. The file is updated automatically whenever a record is added, edited, or
deleted.

Save Subset saves the results of a find, sort, or display operation as a new,
"subset" file. Records in a subset file are in the order that they were displayed,
renumbered starting with 1.

9 Create a subset file (with a new filename) when you want to changethe order of the fields in your file, or get rid of some fields. (If you
don't need the original file any more, erase it.)

Print (<F5> or #4 <CTRL-P> «*) prints the records you are presently
working with, in their current order, with the fields chosen for display except for
labels. See, below, Print Labels.) When you load MANAGE, print values are set
as in the right-hand column on the following page. You can edit or erase the file
name. New settings for Page Numbers or Style remain in effect until you change
them or load the program. (Then they revert to the default values.)

T i t l e ( fi l e n a m e )
Page Numbers (Y or N) Y
S t y l e L
(S-Standard, L-List, C-Chart, N-No field names)
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What print formats mean:
Standard prints records and field names as they are on the

screen when you are entering records.
List prints field names in a left-hand column, field values in a

right-hand column.
Chart prints up to four columns of 19 characters across the page.
No field names prints data only, without field names.

9 MANAGE prints files single-spaced on continuous paper, in four standard styles. Make a Copy for Writer and print with HI A ITE if you want to
use special size paper or change line spacing. (See below.)

Print Labels prints the active records in label form. Use Find and Sort before
you select Print Labels, if you wish to print only certain records, and wish them to
print in sorted order. (For instance, you can print labels in alphabetical order for
just the people who live in Texas.)

Select Print Labels from the menu. A split screen is displayed, with field names dis
played below the line and a label facsimile above. Use up and down arrows to
highlight a field, use right and left arrows to highlight the target for that field, then
press <ENTER/RETURN>. To erase a field from a target, select <BLANKTHIS
FIELD> when the incorrect target is highlighted. The first line can contain two fields
(usually first name and last name). The fifth line can contain three fields (usually
city, state, and zip). The program prints a comma after the first field on this line.

Labels may be from 5 to 14 lines long. The program will not print fields that do
not contain data. (That means that your labels won't have any blank lines.) To
print on form feed labels, set the label depth at the correct number of lines.
Measure from the top edge of one label to the top edge of the next, and multiply
by 6. (Since there are 6 lines to an inch, a 13-line label will print correctly on 2 1/
6" labels. The maximum length is 14 lines--2 1/3 inches.)

When you're satisfied, press S for a Screen test. Records will be displayed, ex
actly as they will print. When you press P for a Print test, the program will print
two labels. You can check to see that labels are printing the way you want be
fore you press <CTRL-X> to print the entire file.

9 If you might sometimes print labels with the last name first, enter
first name and last name in separate fields. If you might sometimes
print labels for addressing mail, enter an extra Title/name field in
which you can enter names as they will appear on the top line of
the label: Mr. Abraham Lincoln, Dr. Albert Schweitzer, Mr. and Mrs.
George Washington, etc.

Copy for Writer copies MANAGE data in aform that can be loaded into 111 A ITE.
It copies the active records, in their current order and format. Select Copy for Writer
and choose "List" or "Chart" format. Name the new file. Open it in HI AITE or insert it
into another LU A ITE file and edit it as any other 111 A ITE file.
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Erase deletes files made FI AST HAND. Use Erase to get rid of old files, and to
free up space on your data disk. Another way to clean house is to use DOS com
mands. (Remember, erase both the .DAT and the .HDR file in MANAGE.)

9 When copying or erasing MANAGE files with DOS, copy or erase
both the .DAT file and the .HDR file. Use * as a short cut. For ex
ample, A>copy ADDRESS. * will copy both files.

EDIT MENU OPTIONS
IMRU File Edit Find Display

Change File Structure.

Rdd Record
Delete Record
Copy Record

Ouerstrike

Change
displays the first field. Use <ARROWS> to move the cursor and make changes;
then press <PgUp> or <PgDn> to move to another field, or press <CTRL-X> (or
<F10>) to save the new structure. To delete fields, use Save Subset. (See above.)

Add Record (AA) After a file structure is saved, a blank form for Record #1 is
displayed. Enter data, using the keys like a typewriter. Use up and down
<ARROWS> or <ENTER/RETURN> to move from field to field. Select Add
Record (or press <CTRL-A>) to add another record. If this is the last record, use
Save Record (or <F3> or tf * <CTRL-S> ##) to save it.

Enter data consistently in every record. For example, when entering months,
type "October" or "10," but not both. Enter the part to use for Sorting first. For
example, to sort friends according to last name, enter the last name first. (If you
might want to sort by first name, enter it in a separate field.) If you combine infor
mation in one field, put information that you may want to sort first. MANAGE
starts sorting at the beginning of a field.

Delete Record (<F6>) deletes the currently-displayed record.

Copy Record (<F7>) copies the record. Use Copy Record to add a new
record that is similar to an old one. Edit the copy, to avoid ending up with two
identical records.

9 Another way to choose a record to edit, copy, or delete is to select
it from a display "As Chart."

Insert (INS or #ft <CTRL-0> ##) switches between Insert and Overstrike
text entry mode.
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FIND MENU OPTIONS
Imru File Edit Find Display

Rll Records

Find...
Sort up...
Sort down...

All Records restores all the records in a file after Find or Sort. Records will be
back in their original order. (To display all fields, see All Fields, below.)

Find locates the records in a file that meet your criteria. When you select Find,
field names are displayed. Use <ARROWS> to move to the field you want, and
enter a "find string" (what you want found).

If you enter a "Find" string without any symbol, the program looks for records
where the field value CONTAINS that string ANYWHERE IN THE FIELD.

If you use the EQUALS symbol (=), the program looks for records where the
field value is an EXACT MATCH for the string, nothing more or nothing less.

If you use the NOT EQUAL TO symbol ( ~ ), the program looks for records where
the field value is ANYTHING ELSE BUT EXACTLY THE VALUE you have typed
in the chosen field (nothing more or nothing less).

If you use the LESS THAN symbol ( < ), the program looks for field values that
are either NUMERICALLY OR ALPHABETICALLY LOWER THAN the string.

If you use the MORE THAN symbol (> ), the program looks for field values that
are either NUMERICALLY OR ALPHABETICALLY HIGHER THAN the string.

Use the symbols below to find records:

Symbol: Means
(none) contain

Example:
Sue

equal to =Glenn,Sue

(exact match)
< l e s s t h a n

=15
<G

<15

> g r e a t e r t h a n >G
>15

Means:
all records where field contains the
string Sue
all records where field contains Glenn,
Sue
all records where field is 15
all records where the field starts with
A-F
all records where field starts with a
number less than 15
all records where field starts with H-Z
all records where the field starts with a
number greater than 15
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Symbol: Means Example: Means:
not ~Glenn,Sue all records where the field

is anything but Glenn, Sue
-15 all records where the field contains

anything but exactly 15

9 When you use the = and ~ symbols, be sure to specify the entirefield value to find, ("exact match") Do not enter spaces in strings,
unless you want the program to search for them.

To perform multiple "finds," enter strings in several fields. For example, to find
friends named Glenn who live anywhere but Oklahoma and who are are younger
than 14:

F i r s t , fi n d b y N a m e G l e n n .
N e x t , fi n d b y S t a t e - O K
L a s t , fi n d b y A g e < 1 4 .

(See above, Save Subset, for information about saving the results of a find oper
ation.)

Sort Up or Sort Down Sorting puts records in order. You can sort the entire
file, or sort the records selected by a Find procedure. MANAGE sorts the first 10
characters in a field.

Sort Up sorts in alphabetical order, from A to Z.
in numerical order, from lowest to highest.

Sort Down sorts in alphabetical order, from Z to A.
in numerical order, from highest to lowest.

Letters are considered "higher" than numbers. That means that, if you Sort Down,
the record beginning with a letter will sort before the record beginning with a number.

You may sort up to three fields at once. All the sorts must be either "up" or
"down." First the program performs SORT-1. Then it sorts the results based on
SORT-2, and finally SORT-3.

If you sorted the ADDRESS file...
SORT-1 by state
SORT-2 by town
SORT-3 by zip

the results would be in order...
alphabetically by state
within state, alphabetically by town
within town, numerically by zip.

(See Save Subset, above, for saving the results of a sort operation.)
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DISPLAY MENU OPTIONS
Imru File Edit Find DisplaP i a ^

Rll Fields
Some Fields..

Rs List
Rs Chart
Uiem/Edit

All fields redisplays all the fields in records after you have displayed "Some
fields."

Some fields selects fields to display or print, and specifies the order in which
they appear. Move to the first field you want displayed, and press <ENTER/
RETURN>. (Press <ENTER/RETURN> again to un-select a field.) Then select
other fields in the order you want. Press <CTRL-X> when you are satisfied.

AS List displays records with field names in a left-hand column and field values
in a right-hand column. To exit this display, select a different one.

As Chart displays up to four equal columns across the screen. If you don't
choose fields, the program displays the first four fields. Use "Some Fields" to
choose up to four fields to display, and their order. To exit this display, select a
different one.

View/Edit When you edit or enter record o displayed in the View/Edit
style. Commands from the Display Menu allow you to change the way records
are displayed. Use the View/Edit command to return to the View/Edit mode after
an "As List" or "As Chart" display.

MANAGE CAPACITY
File name: 8 Characters
File: 500 records, depending on disk space and the

maximum record size
Record: 200 Fields
Field Values: 500 characters
Field Name: 30 characters
Search String: 10 characters
Sort Operations: 3
Chart Display: 4 fields of 19 characters each
Labels: 5 to 14 lines
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